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I. Disclaimer! 

Please note: this is an abbreviated guide. The actual manual for this microscope + software 
package is easily over 300 pages. While it is a good exercise for any student to read the user 
manual when beginning work on a new instrument, this User Guide can serve as a guide to general 
use of the instrument and may be sufficient for many uses. However, in the event that you 
encounter trouble, need more information, or require assistance, contact Amy (email: 
areplogle@pugetsound.edu; location: Room 117H, Thompson Hall; phone: 253-879-2829) or refer 
to the manual for the instrument or software.  
 

II. Safety Considerations 

The confocal microscope utilizes high powered lasers which emit intense beams of light. Though 
risk is minimal since the system is enclosed, some hazards remain. Exposure to lasers may result 
in damage to the eyes or skin, among other hazards. For these reasons, please use the following 
precautions when working on the confocal microscope: 

 

 Never look directly into any laser beam light source. 

 Adhere to all safety warning labels found on the microscope and lasers. 

 Notify a supervisor, faculty member, or other responsible individual immediately if a laser is 
malfunctioning or losing power. 

 
For additional information on laser safety associated with using the confocal microscope, consult 
the Nikon website at http://www.microscopyu.com/articles/fluorescence/lasersafety.html. 
 

III. Confocal Microscopy  

Confocal microscopy is an imaging technique commonly used in the biomedical and life sciences to 
visualize fixed or living cells and tissues, among other applications. Confocal imaging is based on 
principles invented by Marvin Minsky in 1957, and involves the use of point illumination and 
elimination of light transmitted from the out-of-focus planes via a pinhole located in front of the 
detector. This imaging technique provides a significant increase in optical resolution and contrast 
over traditional wide-field fluorescent microscopy, and thus allows for the resolution of fine 
structure, acquisition of 3D images, and achievement of exquisitely-fine focus.  
 

IV. Operation of the Microscope  

Students should always have training on the microscope prior to use! To arrange to be trained, or 
for other assistance, please see Amy in 117H Thompson Hall (areplogle@pugetsound.edu or 253-
879-2829). 
 

A. Start-up procedures  

The following sequence should be used when turning on the microscope (summary located on the wall 
next to the microscope): 
 
1. Sign up on the online instrument calendar located on the science core facility webpage: 

www.pugetsound.edu/sciencecorefacility. 
 

2. Turn on 2) the power strip for the lasers and the epifluorescence camera. This is located in the 
corner on the bench to the left of the microscope. 
 

3. Turn on 3) each laser individually, only if you are planning to do confocal microscopy. These DO 
NOT need to be turned on if you are performing epifluorescence. Ideally, the lasers should be on 

http://www.microscopyu.com/articles/fluorescence/lasersafety.html
http://www.pugetsound.edu/sciencecorefacility
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for 20-30 minutes prior to use. The time that it takes to turn everything on and set up the 
microscope is generally enough time for the lasers to warm up properly. However, in the case of 
quantitative analysis of multiple samples, be sure to wait for an appropriate amount of time (ie, 20-
30 minutes) from start-up to begin collecting images and data. 
 
a. 405 nm laser: Silver control box on the back of main lasers box. Turn the key located on 

the back of the laser. Key in the horizontal (o) position is off. Key in the vertical (l) position 
is on. 

b. 488 nm laser:  
i. Turn the key located on the black controller box to the left of the main lasers box 

(key in the vertical position (o) is off, key in the horizontal position (l) is on); 
ii. When green light stops flashing, push down the green “laser on” button. 

c. 561 nm laser: Silver control box to the front of the main control lasers box. Switch in the 
vertical (o) position is off. Switch in the horizontal (l) position is on. 
 

4. Turn on 4) the powerstrip by the computer. This controls power to the controller and detector. 
 

5. Turn on 5) the computer and monitor. 
 

6. Open the appropriate software for imaging. EZ-C1 for confocal laser scanning or NIS Elements for 
epifluorescence. 
 

B. Finding your sample with conventional microscopy 

1. Make sure the lowest objective is in place, and stage is lowered with the course focus to reduce 
the risk of running the objective into the stage or slide. 
 

2. Place the slide, coverslip-down, on the platform (remember, this is an inverted microscope, so the 
objective is underneath the sample).  
 

3. Be sure the port knobs (located on the right side of the microscope) is pointing to the indicator for 
“EYE”, the shutter is open (lever located just behind the filter turret on the right side of the 
microscope, pushed back to the “O” position), and the filter turret (located just below the 
objectives) is in the transmitted light position “”, which is used for bright field imaging to initially 
find your specimen before switching to fluorescence. 
 

4. Turn on the transmitted light by pressing the white button on the lower left-hand side of the 
microscope. You can adjust the intensity by turning the dial just below the white button. 
 

5. Using the eyepieces, find your cells/tissues/etc., and focus using the coarse focus dial or the 
remote fine focus controller dial. The platform can be moved to reposition your specimen using 
the rod on the right side of the microscope, rather than actually manually moving your slide. 
Note: Depending on your tissue, it might be hard to see with bright field microscopy. If that 
is the case, you might find it helpful to focus on the edge of your coverslip to get you close 
to the plane of focus, then position where you think your sample is over the objective and 
continue on to the next section “Visualizing your sample with epifluorescence”.  

 
6. Start with the 10x objective, find your cells/tissue/etc., and then switch to the 20x, 60x, or 100x 

objective if needed. If using the 60x WI objective, place a drop of double distilled DI water on the 
top of the objective before use. If using the 100x Oil objective, place a small drop of immersion oil 
on your slide. 
Note: The 100x objective is kept the shelf to the left of the microscope. You must be 
trained prior to use of the 100X objective. Please use it carefully, be sure to clean it 
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correctly after use, and take care when mounting and unmounting it. If you need 
assistance, please contact Amy. 
 

C. Visualizing your sample with epifluorescence  

1. Once you have found and focused on your sample using bright field microscopy, turn off the 
transmitted light. 
 

2. Place the filter turret (located just below the objectives) to the correct position for the fluorescence 
you wish to view. Filters are labeled as follows: 

 “UV”: UV excitation, used to visualize DAPI 

 “B”: blue excitation, used to visualize GFP and FITC 

 “G”: green excitation, used to visualize Cy3, TRITC 
 

3. Turn the LED light source on by tapping the foot pedal located on the floor underneath the table 
the microscope is sitting on. Note: Be sure to turn off the LED light source by tapping the 
foot pedal again when you don’t need to visualize fluorescence or if you have switched to 
confocal microscopy. You never want your sample exposed to unnecessary light as this might 
quench your fluorophore, resulting in reduced fluorescence. 

 

V. Using NIS Elements to Image Epifluorescence  

A. Adjusting Image Appearance in NIS Elements 

1. Switch to the computer view: Turn the top portal knob (on the right side of the microscope, across 
from the CoolSnapEZ camera) to “SIDE”. 

 
2. Open the NIS Elements software by double-clicking the icon on the desktop, select Roper 

Scientific and click OK.  

 
 

3. To view the live image, click the   button in the upper left hand corner of the software. You will 
also need to indicate what filter you are currently using for your image to appear the correct color. 
There are several presets in the tool bar, one for each emission color (see image below). Once 
you choose the correct fluorophore the tab at the lower left corner of your live image will display 
the correct label (see image below).  
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4. If you need to change the label, or if the presets have been changed, right click the tab circled in 
red above and choose Properties. In the Name drop-down menu you can choose from a variety of 
fluorophores. Sometimes you may also need to change the color of those presets. Click Close 
when finished. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. To adjust the brightness of the image you will first want to select “Auto Exposure” from the 
CoolSNAP ES Settings on the right-hand side of the screen. 
 

 
 

6. To adjust the appearance of your image you can adjust the LUTs (Lookup Tables) located on the 
right-hand side of the screen.  
 

 During the imaging process, the camera collects the transmitted light and assigns a value to 
each pixel based on its intensity. Brighter pixels are assigned higher intensity values. The 
intensity values are arranged in histograms along the x-axis, with lower intensity values on the 
left and higher intensity values on the right. The height of the bar at a particular intensity value 
represents its pixel population. Higher bars indicate more pixels at that intensity value.  
 

 How these intensity values are assigned, or ‘mapped’, greatly affects the visual appearance of 
the image, although it does not affect the data or quantification in any way. The curve 
overlaying the histogram represents how the intensity values of the data map to the available 
display values. Adjusting the curve changes which of the intensity values are mapped to 
specific display values, and whether they are mapped linearly or logarithmically.  

 

 There are three points on the curve that can be adjusted: 
 
a. The Max Point is at the right of the curve. Moving the Max Point to the left is similar to 

increasing the Contrast. As more of the intensity values are mapped to the brightest 
display values, fluorescence becomes brighter.  
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b. The Min Point is at the left of the curves and marks the lowest display value that is not in 
the background color. Moving the Min Point to the right shades more of the lower intensity 
values to lower display values, creating a visually cleaner background. 

c. The middle point represents the K value. Adjusting it smoothly changes the mapping from 
linear to logarithmic. Changing to a more logarithmic mapping reduces the contrast 
between the higher and lower intensity values by applying a log scale, so higher and lower 
intensity values are mapped to display values that are closer together. This ‘compression’ 
of the intensity values may improve the appearance of the less intense bands, while 
avoiding very bright bands.  
 

 
 

B. Capturing and Saving Epifluorescent Images 

1. To capture the image click the camera icon in the tool bar. This will open a new window with your 
captured image.  
 

2. To save the image, go to “File” then choose “Save As” and find your folder. Note all students must 
have a subfolder within their adviser’s folder.  
 

3. Give your file a name and select what kind of file type you’d like to save your image as. There are 
three recommendations. NOTE: If you save your image in TIFF or JPEG formats you must 
include the magnification in your image name or write it down in your lab notebook in 
order to go back and calibrate the image to the correct scale bar or make measurements. 
 
a. ND2 Image File Format. This saves your image in the proprietary NIS Elements formats 

that allows you to keep information about the instrumentation such as instrument type and 
magnification with your image. This is particularly helpful if you don’t have a file naming 
convention that includes the magnification your image was acquired at. You can process 
your image in this file format and then save it in one of the following formats without the 
risk of losing image quality. 
 

b. TIFF, Tagged Image Format. This is a powerful image format that is the standard for 
graphic artists, publishing, and photography. TIFFs are a lossless formatting meaning that 
a TIFF image may be edited and re-saved without losing image quality. One disadvantage 
to TIFFs is that they can’t always be viewed on all devices.  
 

c. JPEG, Tagged Image Format. This is a particularly useful file type that can be viewed on 
virtually any device. The disadvantage to using JPEGs is that image quality may be lost 
when editing and resaving your image.  

Max Point 
Min Point 

middle point 
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C. Merging Captured Epifluorescent Images in NIS Elements 

If you have a sample with more than one fluorophore you can merge together two fluorescent images 

and/or merge a fluorescent image with a brightfield image.   

1. Go to the “File” tab then click “Merge Images…”. 

2. In the “Merge Images” window that appears you will select the file name of the images you want to 

merge from the drop down menu under the appropriately colored component or Brightfield option, 

then click “OK”.   

 

3. Save the image according to the instructions in section B above. If you need to annotate your image 

with text, arrows, scale bar, or make measurements see section 5E below. 

D. Stitching Multiple Epifluorescent Images together in NIS Elements 

If you have a large sample or piece of tissue you want to see all together at once you can capture 

multiple images and then stitch them together. 

1. Capture your images in a systematic way by always moving across in the same direction or down in 

a column. Also make sure you capture the image for all fluorophores or under brightfield before 

moving on to the next area. Note: Images must be saved in a file format other than .ND2, such 

as JPEG or TIFF in order to stitch them together.  
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2. Go to the “File” tab then click “Stitch Larger Image from Files…”, then open your image sequence 

by navigating to the folder for the images that you want to stitch together.  

 

3. Select the correct layout options so that your image is stitched together in the correct order. It’s 

helpful if you remember the direction you moved to obtain images and how many columns you 

captured. Click Stitch.  

  

E. Annotating Images in NIS Elements 

1. Scale Bars 

a. Adding a scale bar 

i. On the right hand side of your image there will be a tool bar. To add a scale bar, 

select the icon that that has “µm” on it.  

ii. If you are adding it to a .ND2 file, a calibrated scale will be added and you can 

proceed with editing the scale bar properties. If you are adding it to any other file 

type you will need to calibrate the scale bar from pixels to µm.  

iii. To calibrate your scale you will need to right click on “Uncalibrated” which is located 

on the bottom of your image window to bring up the calibration menu.  

iv. Select “Calibrate using Objective” and then click on the appropriate objective. You 

should not have a scale bar on your image (see example below) and proceed with 

editing scale bar properties.  
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b. Edit scale bar properties 

i. To change the appearance of your scale bar, click on the small arrow to the right of 

the “µm” icon and select “Scale Properties…” 

ii. In the new window that opens you can select the orientation, appearance, size, and 

font of your scale bar, then click “OK”. 

 

c. Saving an image with a scale bar 

In NIS Elements, annotations act like layers (or overlays) in an image. In order to have the 

scale bar appear on your saved image you first need to insert the overlay by going to the 

“Edit” tab, then select “Insert Overlay”. You can now save the image according to the 

instructions in section 5B above. Note: It is recommended to save your annotated image 

as a new file name so you always have your original image to go back to.  
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2. Take Measurements 

a. Annotations and Measurements toolbox 

i. There are a number of measurements that the NIS Elements software can do with a 

calibrated (correctly scaled image) that a pretty self-explanatory once you find the 

tools. The “Annotations and Measurements” toolbox can be found in the lower left 

hand side of the screen beneath the “CoolSNAP ES Settings” and “LUTs” toolboxes. 

Sometimes this toolbox accidently gets closed. To view it again go to the “Measure” 

tab at the top of the screen and select the measurement you would like to make.  

 

ii. One nice feature of the “Annotations and Measurements” toolbox is that it will keep 

track of any measurements or counts that you have made in an Excel Spreadsheet 

across a set of pictures. This spreadsheet can be exported and saved.  

 

b. Saving an image with annotations 

Remember: In NIS Elements, annotations act like layers (or overlays) in an image. In order 

to have the scale bar appear on your saved image you first need to insert the overlay by 

going to the “Edit” tab, then select “Insert Overlay”. You can now save the image according 

to the instructions in section 5B above. Note: It is recommended to save your annotated 

image as a new file name so you always have your original image to go back to. 

 

 
 
 
 
 
 
 


